ENESAS Release Note

e2 studio 6.0.0 R20UT4092EE0100

Rev.1.00
Release Note August 31, 2017
Introduction

This document outlines the device support, new features added in 6.0.0, fixed issues and open issues in €2 studio 6.0.0.
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e2 studio

6.0.0

Release Note

1. Product Information

1.1 Supported Operating Systems
These operating systems are officially supported by €? studio:

1.2 Supported Toolchains

Windows 7 32-bit
Windows 7 64-bit
Windows 8.1 32-bit
Windows 8.1 64-bit
Windows 10 32-bit
Windows 10 64-bit

The following toolchains are supported in €2 studio 6.0.0.

Renesas Launchpad Renesas GCC/ IAR (*4) Green Hills (*5)
GCC (*2) KPIT GCC (*3)
RL78 Yes (CC-RL) No Yes Yes No
E RX Yes (CC-RX) No Yes Yes No
'ZE RH850 No No No Yes Yes
é RZ/ARM No No (*1) Yes Yes No
Synergy/ARM No Yes No Yes No
Note:

*1: Converter is now available to convert RZ ARM-none GCC toolchain to use Launchpad GCC.

*2: The GNU Launchpad toolchain is distributed via the www.launchpad.net website and is available
here: https://launchpad.net/gcc-arm-embedded.

*3: Legacy KPIT GCC toolchains are now available from www.renesas-gcc.com. In addition, the latest RX
and RL Renesas GCC toolchains are available from this website.

*4: The IAR toolchain plugins are available via the “Help”->"IAR Embedded Workbench plugin manager”
menu in e2 studio. These Eclipse plugins are provided by IAR and are not supported by Renesas.

*5: The Green Hills toolchain plugins are available within the e2 studio product. These plugins are provided
by Green Hills and are not supported by Renesas.
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2. Device Support

2.1 Project Generator Support
Note: The Renesas SH device family is no longer supported in e2 studio.

CPU Family Devices

EC-1 EC-1 R9A06G043
ClH R7F701260, R7F701270,(Debug Support Only)
CiM R7F701263, R7F701271,(Debug Support Only)
E1L R7F701201, R7F701205,(Debug Support Only)
E1M-S R7F701202, R7F701204,(Debug Support Only)

- R7F701Z05, R7F701Z06, R7F701207,(Debug Support Only)
R7F701501, R7F701502, R7F701503, R7F701506, R7F701507,
F1H R7F701508, R7F701511, R7F701512, R7F701513,(Debug Support Only)

F1H-GW R7F701521, R7F701522, R7F701524, R7F701525,(Debug Support Only)
R7F701542, R7F701543, R7F701546, R7F701547, R7F701557,
R7F701560, R7F701561, R7F701562, R7F701563, R7F701566,
R7F701567, R7F701577, R7F701580, R7F701581, R7F701582,
R7F701583, R7F701586, R7F701587, R7F701597, R7F701602,
R7F701603, R7F701610, R7F701611, R7F701612, R7F701613,

F1K R7F701620, R7F701621, R7F701622, R7F701623,(Debug Support Only)
R7F701002xAFP, R7F701003xAFP, R7F701006xAFP, R7F701007XAFP,
R7F701008xAFP, R7F701009xAFP, R7F701010xAFP, R7F701011xAFP,
R7F701012xAFP, R7F701013xAFP, R7F701014xAFP, R7F701015xAFP,
R7F701016XAFP, R7F701017xAFP, R7F701018xAFP, R7F701019xAFP,

RH850 R7F701020xAFP, R7F701021xAFP, R7F701022xAFP, R7F701023xAFP,
R7F701024xAFP, R7F701025xAFP, R7F701026xAFP, R7F701027XAFP,
R7F701028xAFP, R7F701029xAFP, R7F701030xAFP, R7F701032XAFP,
R7F701033xAFP, R7F701034xAFP, R7F701040, R7F701041, R7F701042,
R7F701043, R7F701044, R7F701045, R7F701046, R7F701047,
R7F701048, R7F701049, R7F701050, R7F701051, R7F701052,
R7F701053, R7F701054, R7F701055, R7F701056, R7F701057,(Debug

F1L Support Only)

R7F701544, R7F701545, R7F701548, R7F701549, R7F701552,
R7F701553, R7F701564, R7F701565, R7F701568, R7F701569,

FIM R7F701572, R7F701573,(Debug Support Only)

R7F701304, R7F701305, R7F701310, R7F701311, R7F701312,
R7F701313, R7F701314, R7F701315, R7F701318, R7F701319,

P1IM R7F701320, R7F701321, R7F701322, R7F701323,(Debug Support Only)
R7F701375, R7F701376, R7F701377, R7F701378, R7F701379,
R7F701380, R7F701381, R7F701382, R7F701383, R7F701384,

P1M-E R7F701385, R7F701386,(Debug Support Only)

R7F701060xAFP, R7F701062xAFP, R7F701064xAFP, R7F701065xAFP,
R7F701067xAFP, R7F701069xAFP, R7F701071xAFP,(Debug Support

- Only)

R5F10CGB, R5F10CGC, R5F10CGD, R5F10CLD, R5F10CMD, R5F10CME,

R5F10DGC, R5F10DGD, R5F10DGE, RSF10DLD, R5F10DLE, RSF10DMD,

R5F10DME, R5F10DMF, R5F10DMG, R5F10DMJ, RSF10DPE, RSF10DPF,

R5F10DPG, R5SF10DPJ, R5F10DPK, R5SF10DPL, RSF10DS), RSF10DSK,
D1A R5F10DSL, R5F10TPJ

RL78 R5F10968, R5F1096A, R5F1096B, R5F1096C, R5F1096D, R5F1096E,
R5F109AA, R5F109AB, R5F109AC, R5F109AD, R5F109AE, R5F109BA,
R5F109BB, R5F109BC, R5F109BD, R5F109BE, R5F109GA, R5F109GB,
R5F109GC, R5F109GD, R5F109GE, R5F109LA, R5F109LB, R5F109LC,
F12 R5F109LD, R5F109LE
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R5F10A6A, R5F10A6C, R5F10A6D, R5F10A6E, R5F10AAA, R5F10AAC,
R5F10AAD, RSF10AAE, R5F10ABA, R5F10ABC, R5F10ABD, R5F10ABE,
R5F10AGA, R5F10AGC, R5F10AGD, R5F10AGE, R5F10AGF, R5F10AGG,
R5F10ALC, R5F10ALD, R5F10ALE, R5F10ALF, R5F10ALG, R5F10AME,
R5F10AMF, R5F10AMG, R5F10BAC, R5F10BAD, R5F10BAE, R5F10BAF,
R5F10BAG, R5F10BBC, R5F10BBD, R5F10BBE, R5F10BBF, R5F10BBG,
R5F10BGC, R5F10BGD, R5F10BGE, R5F10BGF, R5F10BGG, R5F10BLC,
R5F10BLD, R5F10BLE, R5F10BLF, R5F10BLG, R5F10BME, R5F10BMF,
F13 R5F10BMG
R5F10PAD, R5F10PAE, R5F10PBD, R5F10PBE, R5F10PGD, R5F10PGE,
R5F10PGF, R5F10PGG, R5F10PGH, R5F10PGJ, R5F10PLE, RSF10PLF,
R5F10PLG, R5F10PLH, R5F10PLJ, R5F10PME, R5F10PMF, R5F10PMG,
R5F10PMH, R5F10PMJ, R5F10PPE, R5F10PPF, R5F10PPG, R5F10PPH,
F14 R5F10PPJ
R5F113GK, R5F113GL, R5F113LK, R5F113LL, R5F113MK, R5F113ML,
R5F113PG, R5F113PH, R5F113PJ, R5F113PK, R5F113PL, R5F113TG,

F15 R5F113TH, R5F113TJ, R5F113TK, R5SF113TL
F1A R5F114GC, R5F114GD, R5F114GE, R5F114GF, R5F114GG
G10 R5F10Y14, R5F10Y16, R5F10Y17, R5F10Y44, R5F10Y46, RSF10Y47

R5F1056A, R5F1057A, R5SF1058A

G11 R5F1051A, R5F1054A,(Debug Support Only)
R5F10266, R5F10267, R5F10268, R5F10269, R5F1026A, R5F10277,
R5F10278, R5F10279, R5F1027A, R5F102A7, R5F102A8, R5F102A9,
R5F102AA, R5F10366, R5F10367, R5F10368, R5F10369, R5F1036A,
R5F10377, R5F10378, R5F10379, R5F1037A, R5F103A7, RSF103A8,

G12 R5F103A9, R5F103AA
R5F1006A, R5F1006C, R5F1006D, R5F1006E, R5F1007A, R5F1007C,
R5F1007D, R5F1007E, R5F1008A, R5F1008C, R5F1008D, R5F1008E,
R5F100AA, R5F100AC, R5F100AD, R5F100AE, R5F100AF, R5F100AG,
R5F100BA, R5F100BC, R5F100BD, R5F100BE, R5F100BF, R5F100BG,
R5F100CA, R5F100CC, R5F100CD, R5F100CE, R5F100CF, R5F100CG,
R5F100EA, R5F100EC, R5F100ED, R5F100EE, R5F100EF, R5F100EG,
R5F100EH, R5F100FA, R5F100FC, R5F100FD, R5F100FE, R5F100FF,
R5F100FG, R5F100FH, R5F100FJ, R5F100FK, R5F100FL, R5F100GA,
R5F100GC, R5F100GD, R5F100GE, R5F100GF, R5F100GG, R5F100GH,
R5F100GJ, R5F100GK, R5F100GL, R5F100JC, R5F100JD, R5F1001JE,
R5F100JF, R5F100JG, R5F100JH, R5F100JJ, R5F100JK, R5F100IL,
R5F100LC, R5F100LD, R5F100LE, R5F100LF, R5F100LG, R5F100LH,
R5F100LJ, R5F100LK, R5F100LL, R5F100MF, R5F100MG, R5F100MH,
R5F100MJ, R5F100MK, R5F100ML, R5F100PF, R5F100PG, R5F100PH,
R5F100PJ, R5SF100PK, R5F100PL, R5F100SH, R5F100SJ, R5F100SK,
R5F100SL, R5F1016A, R5F1016C, R5F1016D, R5F1016E, R5F1017A,
R5F1017C, R5F1017D, R5F1017E, R5F1018A, R5F1018C, R5F1018D,
R5F1018E, R5F101AA, R5F101AC, R5F101AD, R5F101AE, R5F101AF,
R5F101AG, R5F101BA, R5F101BC, R5F101BD, R5F101BE, R5F101BF,
R5F101BG, R5F101CA, R5F101CC, R5F101CD, R5F101CE, R5F101CF,
R5F101CG, R5F101EA, R5F101EC, R5F101ED, R5F101EE, RSF101EF,
R5F101EG, R5F101EH, R5F101FA, R5F101FC, R5F101FD, RSF101FE,
R5F101FF, R5F101FG, R5F101FH, R5F101FJ, R5F101FK, R5F101FL,
R5F101GA, R5F101GC, R5F101GD, R5F101GE, R5F101GF, R5F101GG,
R5F101GH, R5F101GJ, R5F101GK, R5F101GL, R5F101JC, R5F101JD,
R5F101JE, R5F101JF, R5F101JG, R5F101JH, R5F101JJ, R5F101JK,
R5F101JL, R5F101LC, R5F101LD, R5F101LE, R5F101LF, R5F101LG,
R5F101LH, R5F101LJ, R5F101LK, R5F101LL, R5F101MF, R5F101MG,

G13 R5F101MH, R5F101MJ, R5F101MK, R5F101ML, R5F101PF, R5F101PG,
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R5F101PH, R5F101PJ, R5F101PK, R5F101PL, R5F101SH, R5F1015SJ,
R5F101SK, R5F101SL
R5F104AA, R5F104AC, R5F104AD, R5F104AE, R5F104AF, R5F104AG,
R5F104BA, R5F104BC, R5F104BD, R5F104BE, R5F104BF, R5F104BG,
R5F104CA, R5F104CC, R5F104CD, R5F104CE, R5F104CF, R5F104CG,
R5F104EA, R5F104EC, R5F104ED, R5F104EE, R5F104EF, R5F104EG,
R5F104EH, R5F104FA, R5F104FC, R5F104FD, R5F104FE, R5F104FF,
R5F104FG, R5F104FH, R5F104F), R5F104GA, R5F104GC, R5F104GD,
R5F104GE, R5F104GF, R5F104GG, R5F104GH, R5F104GJ, R5F104GK,
R5F104GL, R5F104JC, R5F104JD, R5F104JE, R5F104JF, R5F104JG,
R5F104JH, R5F104JJ, R5F104LC, R5F104LD, R5F104LE, R5F104LF,
R5F104LG, R5F104LH, R5F104LJ, R5F104LK, R5F104LL, RSF104MF,
R5F104MG, R5F104MH, R5F104MJ, R5F104MK, R5F104ML, R5F104PF,
G14 R5F104PG, R5F104PH, R5F104PJ, R5F104PK, R5F104PL
R5F10E8A, R5F10E8C, R5F10E8D, R5F10E8E, RSF10EBA, R5F10EBC,
R5F10EBD, R5F10EBE, R5F10EGA, R5F10EGC, R5F10EGD, R5F10EGE,

G1A R5F10ELC, R5F10ELD, RSF10ELE
G1C R5F10JBC, R5F10JGC, R5F10KBC, R5F10KGC
G1D R5F11AGG, R5F11AGH, R5F11AG)
G1E R5F10FLC, R5F10FLD, R5F10FLE, RSF10FMC, R5SF10FMD, RSF10FME
R5F11B7C, R5F11B7E, R5F11BBC, R5F11BBE, R5F11BCC, R5F11BCE,
G1F R5F11BGC, R5F11BGE, R5F11BLC, R5F11BLE
G1G R5F11EAS8, R5F11EAA, R5F11EBS8, R5F11EBA, R5F11EF8, R5F11EFA
G1H R5F11FLJ, R5F11FLK, R5F11FLL
I11A R5F1076C, R5F107AC, R5F107AE, R5F107DE
11B R5F10MME, R5SF10MMG, R5F10MPE, RSF10MPG
R5F10NLE, R5F10NLG, R5F10NME, R5SF10NMG, R5F10NMJ, R5F10NPG,
11C R5F10NPJ
R5F11768, R5F1176A, R5F11778, R5F1177A, R5F117A8, R5F117AA,
11D R5F117AC, R5F117BA, R5F117BC, R5F117GA, R5F117GC
I1E R5F11CBC, R5F11CCC

R5F10RB8, R5F10RBA, R5F10RBC, R5F10RF8, R5F10RFA, R5F10RFC,
R5F10RG8, R5F10RGA, R5F10RGC, R5F10RJ8, R5F10RJA, R5F10RIC,

L12 R5F10RLA, R5F10RLC
R5F10WLA, R5F10WLC, R5F10WLD, R5F10WLE, R5F10WLF, R5F10WLG,
R5F10WMA, R5F10WMC, R5F10WMD, R5F10WME, R5F10WMF,

L13 R5F10WMG
R5F11MMD, R5F11MME, R5F11MMF, R5F11MPE, R5F11MPF,
L1A R5F11MPG

R5F110ME, R5F110MF, R5F110MG, R5F110MH, R5F110MJ, R5F110NE,
R5F110NF, R5F110NG, R5F110NH, R5F110NJ, R5F110PE, R5F110PF,
R5F110PG, R5F110PH, R5F110PJ, R5F111ME, R5F111MF, R5F111MG,
R5F111MH, R5F111MJ, R5F111NE, R5F111NF, R5F111NG, R5F111NH,

L1C R5F111NJ, R5F111PE, R5F111PF, R5F111PG, R5F111PH, R5F111P)J

110 R5F51101, R5F51103, R5F51104, R5F51105, R5F5110H, R5F5110)
R5F51111, R5F51113, R5F51114, R5F51115, R5F51116, R5F51117,

111 R5F51118, R5F5111)

113 R5F51135, R5F51136, R5F51137, R5F51138

RX 130 R5F51303, R5F51305, R5F51306, R5F51307, R5F51308

R5F52103, R5F52104, R5F52105, R5F52106, R5F52107, R5F52108,

210 R5F5210A, R5F5210B

21A R5F521A6, R5F521A7, R5F521A8

220 R5F52201, R5F52203, R5F52205, R5F52206
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230 R5F52305, R5F52306

231 R5F52315, R5F52316, R5F52317, R5F52318

23T R5F523T3, R5F523T5

24T R5F524T8, R5F524TA, R5F524TB, R5F524TC, R5F524TE
24U R5F524UB, R5F524UC, R5F524UE

610 R5F56104, R5F56106, R5F56107, R5F56108

621 R5F56216, R5F56217, R5F56218

62G R5F562G7, R5F562GA

62N R5F562N7, R5F562N8

62T R5F562T6, R5F562T7, RSF562TA

630 R5F56307, R5F56308, R5F5630A, R5F5630B, R5F5630D, R5F5630E

R5F56316, R5F56317, R5F56318, R5F5631A, R5F56318B, R5F5631D,
R5F5631E, R5F5631F, R5F5631G, R5F5631J, R5F5631K, R5F5631M,
R5F5631MF, R5F5631N, R5F5631P, R5F5631PF, R5F5631W, R5F5631Y,

631 R5556310
R5F5634B, R5F5634B_5V, R5SF5634D, R5F5634D_5V, RSF5634E,
634 R5F5634E_5V
R5F563NA, R5SF563NB, R5F563ND, R5F563NE, R5F563NF, R5F563NK,
63N R5F563NW, R5F563NY
R5F563T4, RSF563T5, RSF563T6, R5F563TB, RSF563TB_5V, RSF563TC,
63T RSF563TC_5V, RSF563TE, RSF563TE_5V
64M RSF564MF, RSF564MG, RSF564MJ, RSF564ML
R5F56514, R5F56517, R5F56519, RSF5651C, R5F5651C_DUAL,
651 R5F5651E, RSF5651E_DUAL
R5F565N4, R5F565N7, R5SF565N9, R5F565NC, RSF565NC_DUAL,
65N R5F565NE, RSF565NE_DUAL
71M RSF571MF, R5F571MG, RSF571MJ, RSF571ML

R75721000, R75721000_DualSPI, R75721001, R75721001_DualSPI,
R75721010, R75721010_DualSPI, R75721011, R75721011_DualSPI,
R75721020, R75721020_DualSPI, R75721021, R7S721021_DualSPI,
R75721030, R75721030_DualSPI, R75721031, R7S721031_DualSPI,

Al R75721034, R75721034_DualSPI
R75910001, R75910002, R75910006, R75910007, R75910011,

RZ R75910013, R75910015, R75S910015_M3, R75910016, R75910016_M3,

R75910017, R75910017_M3, R75910018, R75910018_M3, R75910025,
R75910026, R75910027, R75910028, R75910035, R75910036,
R75910101, R75910102, R75910106, R75910107, R75910111,
R75910113, R75910115, R75S910115_M3, R75910116, R75910116_M3,
R75910117, R75910117_M3, R75910118, R75910118_M3, R75910125,

T1 R75910126, R75910127, R75910128, R75910135, R75910136
R7FS124762A01CLM, R7FS124763A01CFL
R7FS124763A01CFM, R7FS124772A01CLM,

S124 R7FS124773A01CFL, R7FS124773A01CFM,
R7FS124773A01CNB, R7FS124773A01CNE,
R7FS124773A01CNF
R7FS3A77C2A01CLK, R7FS3A77C3A01CFB,
R7FS3A77C2A01CBJ, R7TFS3A77C3A01CFP,
R7FS3A77C2A01CLJ, R7TFS3A77C3A01CFM,
R7FS3A77C3A01CNB
R7FS5D97C2A01CBG, R7FS5D97C2A01CLK
R7FS5D97C3A01CFB, R7FS5D97C3A01CFC,

S5D9 R7FS5D97C3A01CFP, R7FS5D97E2A01CBG,
R7FS5D97E2A01CLK, R7TFS5D97E3A01CFB,
R7FS5D97E3A01CFC, R7TFS5D97E3AQ1CFP

Synergy *1 S3A7
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R7FS7G27G2A01CBD, R7FS7G27G2A01CBG,
R7FS7G27G2A01CLK, R7TFS7G27G3A01CFB,

S7G2 R7FS7G27G3A01CFC, R7TFS7G27G3A01CFP,
R7FS7G27H2A01CBD, R7FS7G27H2A01CBG,
R7FS7G27H2A01CLK, R7FS7G27H3A01CFB,
R7FS7G27H3A01CFC

Note: *1: The Synergy Software Package (SSP) can supply additional Synergy device support. Please check
the release note for the SSP version you are using for additional device support.
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2.2 Code Generator Support

CPU Family Devices

R5F10CGB, R5F10CGC, R5F10CGD, R5F10CLD, R5F10CMD,
R5F10CME, R5F10DGC, R5F10DGD, R5F10DGE, R5F10DLD,
R5F10DLE, R5F10DMD, R5F10DME, R5F10DMF, R5F10DMG,
R5F10DMJ, R5F10DPE, R5F10DPF, R5F10DPG, R5F10DPJ,
R5F10DPK, R5F10DPL, R5F10DSJ, R5F10DSK, R5F10DSL,
D1A R5F10TPJ
R5F10968, R5F1096A, R5F1096B, R5F1096C, R5F1096D,
R5F1096E, R5F109AA, R5F109AB, R5F109AC, R5F109AD,
R5F109AE, R5F109BA, R5F109BB, R5F109BC, R5F109BD,
R5F109BE, R5F109GA, R5F109GB, R5F109GC, R5F109GD,
R5F109GE, R5F109LA, R5F109LB, R5F109LC, R5F109LD,
F12 R5F109LE
R5F10A6A, R5F10A6C, R5F10A6D, R5F10A6E, RSF10AAA,
R5F10AAC, R5F10AAD, R5F10AAE, R5F10ABA, R5F10ABC,
R5F10ABD, R5F10ABE, R5F10AGA, R5F10AGC, R5F10AGD,
R5F10AGE, R5F10AGF, R5F10AGG, R5F10ALC, R5F10ALD,
R5F10ALE, R5F10ALF, R5F10ALG, R5F10AME, R5F10AMF,
R5F10AMG, R5F10BAC, R5F10BAD, R5F10BAE, RSF10BAF,
R5F10BAG, R5F10BBC, R5F10BBD, R5F10BBE, R5F10BBF,
R5F10BBG, R5F10BGC, R5F10BGD, R5F10BGE, R5F10BGF,
R5F10BGG, R5F10BLC, R5F10BLD, R5F10BLE, RSF10BLF,
F13 R5F10BLG, R5F10BME, R5F10BMF, R5F10BMG
R5F10PAD, R5F10PAE, R5F10PBD, R5F10PBE, R5F10PGD,
R5F10PGE, R5F10PGF, R5F10PGG, R5F10PGH, R5F10PGJ,
R5F10PLE, R5F10PLF, R5F10PLG, R5F10PLH, R5F10PLJ,
R5F10PME, R5F10PMF, R5F10PMG, R5F10PMH, R5F10PMJ,
F14 R5F10PPE, R5F10PPF, R5F10PPG, R5F10PPH, R5F10PPJ
RL78 R5F113GK, R5F113GL, R5F113LK, R5F113LL, R5F113MK,
R5F113ML, R5F113PG, R5F113PH, R5F113PJ, R5F113PK,
R5F113PL, R5F113TG, R5F113TH, R5F113TJ, R5F113TK,

F15 R5F113TL

F1A R5F114GC, R5F114GD, R5F114GE, R5F114GF, R5F114GG
R5F10Y14, R5F10Y16, R5F10Y17, R5F10Y44, R5F10Y46,

G10 R5F10Y47

G111 R5F1051A, R5F1054A, R5F1056A, R5F1057A, R5F1058A

R5F10266, R5F10267, R5F10268, R5F10269, R5F1026A,
R5F10277, R5F10278, R5F10279, R5F1027A, R5F102A7,
R5F102A8, R5F102A9, R5F102AA, R5F10366, R5F10367,
R5F10368, R5F10369, R5F1036A, R5F10377, R5F10378,
R5F10379, R5F1037A, R5F103A7, R5F103A8, R5F103A9,
G12 R5F103AA
R5F1006A, R5F1006C, R5F1006D, R5F1006E, R5F1007A,
R5F1007C, R5F1007D, R5F1007E, R5F1008A, R5F1008C,
R5F1008D, R5F1008E, R5F100AA, R5F100AC, R5F100AD,
R5F100AE, R5F100AF, R5F100AG, R5F100BA, R5F100BC,
R5F100BD, R5F100BE, R5F100BF, R5F100BG, R5F100CA,
R5F100CC, R5F100CD, R5F100CE, R5F100CF, R5F100CG,
R5F100EA, R5F100EC, R5F100ED, R5F100EE, R5F100EF,
R5F100EG, R5F100EH, R5F100FA, R5F100FC, R5F100FD,
R5F100FE, R5F100FF, R5F100FG, R5F100FH, RSF100F],
R5F100FK, R5F100FL, R5F100GA, R5F100GC, R5F100GD,
R5F100GE, R5F100GF, R5F100GG, R5F100GH, R5F100GJ,
R5F100GK, R5F100GL, R5F100JC, R5F100JD, R5F100JE,
G13 R5F100JF, R5F100JG, R5F100JH, R5F100JJ, R5F100JK,
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R5F100JL, R5F100LC, R5F100LD, R5F100LE, R5F100LF,
R5F100LG, R5F100LH, R5F100LJ, R5F100LK, R5F100LL,
R5F100MF, R5F100MG, R5F100MH, R5F100MJ, R5F100MK,
R5F100ML, R5F100PF, R5F100PG, R5F100PH, RSF100PJ,
R5F100PK, R5F100PL, R5F100SH, RSF100SJ, RSF100SK,
R5F100SL, R5F1016A, R5F1016C, R5F1016D, RSF1016E,
R5F1017A, RSF1017C, R5F1017D, R5F1017E, RSF1018A,
R5F1018C, R5F1018D, R5F1018E, R5F101AA, RSF101AC,
R5F101AD, R5F101AE, R5F101AF, R5F101AG, R5F101BA,
R5F101BC, R5F101BD, R5F101BE, R5F101BF, R5F101BG,
R5F101CA, R5F101CC, R5F101CD, R5F101CE, R5F101CF,
R5F101CG, R5F101EA, R5F101EC, R5F101ED, R5F101EE,
R5F101EF, R5F101EG, R5F101EH, R5F101FA, R5F101FC,
R5F101FD, R5F101FE, R5F101FF, R5F101FG, R5F101FH,
R5F101FJ, R5F101FK, R5F101FL, R5F101GA, R5F101GC,
R5F101GD, R5F101GE, R5F101GF, R5F101GG, R5F101GH,
R5F101GJ, R5F101GK, R5F101GL, R5F101JC, R5F101JD,
R5F101JE, R5F101JF, R5F101JG, R5F101JH, R5F101J3J,
R5F101JK, R5F101JL, R5F101LC, R5F101LD, R5F101LE,
R5F101LF, R5F101LG, R5F101LH, R5F101LJ, RSF101LK,
R5F101LL, R5F101MF, R5F101MG, R5F101MH, R5F101MJ,
R5F101MK, R5F101ML, R5F101PF, R5F101PG, R5F101PH,
R5F101PJ, R5F101PK, R5F101PL, R5F101SH, R5F101SJ,
R5F101SK, R5F101SL

G14

R5F104AA, R5F104AC, R5F104AD, R5F104AE, R5F104AF,
R5F104AG, R5F104BA, R5F104BC, R5F104BD, R5F104BE,
R5F104BF, R5F104BG, R5F104CA, R5F104CC, R5F104CD,
R5F104CE, R5F104CF, R5F104CG, R5F104EA, R5F104EC,
R5F104ED, R5F104EE, R5F104EF, R5F104EG, R5F104EH,
R5F104FA, R5F104FC, R5F104FD, RSF104FE, RSF104FF,
R5F104FG, R5F104FH, R5F104FJ, RSF104GA, R5F104GC,
R5F104GD, R5F104GE, R5F104GF, R5F104GG, R5F104GH,
R5F104GJ, R5F104GK, R5F104GL, R5F104JC, R5F104JD,
R5F104JE, R5F104JF, R5F104JG, R5F104JH, R5F104JJ,
R5F104LC, R5F104LD, R5F104LE, RSF104LF, R5F104LG,
R5F104LH, R5F104LJ, R5F104LK, R5F104LL, R5F104MF,
R5F104MG, R5F104MH, R5F104MJ, R5F104MK, R5F104ML,
R5F104PF, R5F104PG, R5F104PH, R5F104PJ, R5F104PK,
R5F104PL

G1A

R5F10E8A, R5F10E8C, R5F10E8D, R5F10E8E, R5F10EBA,
R5F10EBC, R5F10EBD, R5F10EBE, R5F10EGA, R5F10EGC,
R5F10EGD, R5F10EGE, R5F10ELC, R5F10ELD, R5F10ELE

Gl1C

R5F10JBC, R5F10JGC, R5F10KBC, R5F10KGC

GiD

R5F11AGG, R5F11AGH, R5F11AGJ

G1E

R5F10FLC, R5F10FLD, R5F10FLE, R5F10FMC, R5F10FMD,
R5F10FME

G1F

R5F11B7C, R5F11B7E, R5F11BBC, R5F11BBE, R5F11BCC,
R5F11BCE, R5F11BGC, R5F11BGE, R5F11BLC, R5F11BLE

Gi1G

R5F11EA8, R5F11EAA, R5F11EBS8, R5F11EBA, R5F11EFS,
R5F11EFA

G1H

R5F11FLJ, R5F11FLK, R5F11FLL

11A

R5F1076C, R5F107AC, R5F107AE, R5F107DE

11B

R5F10MME, R5F10MMG, R5F10MPE, R5F10MPG

11C

R5F10NLE, R5F10NLG, R5F10NME, R5F10NMG, R5F10NMJ,
R5F10NPG, R5F10NPJ

11D

R5F11768, R5F1176A, R5F11778, R5F1177A, R5F117A8,
R5F117AA, R5F117AC, R5F117BA, R5F117BC, R5F117GA,
R5F117GC
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I1E R5F11CBC, R5F11CCC
R5F10RB8, R5F10RBA, R5F10RBC, R5F10RF8, R5F10RFA,
R5F10RFC, R5F10RG8, R5F10RGA, R5F10RGC, R5F10RJS,
L12 R5F10RJA, R5F10RJC, R5F10RLA, R5F10RLC
R5F10WLA, R5F10WLC, R5F10WLD, R5F10WLE, R5F10WLF,
R5F10WLG, R5F10WMA, R5F10WMC, R5F10WMD, R5F10WME,
L13 R5F10WMF, R5F10WMG
R5F11MMD, R5F11MME, R5F11MMF, R5F11MPE, R5F11MPF,
L1A R5F11MPG
R5F110ME, R5F110MF, R5F110MG, R5F110MH, R5F110MJ,
R5F110NE, R5F110NF, R5F110NG, R5F110NH, R5F110NJ,
R5F110PE, R5F110PF, R5F110PG, R5F110PH, R5F110PJ,
R5F111ME, R5F111MF, R5F111MG, R5F111MH, R5F111MJ,
R5F111NE, R5F111NF, R5F111NG, R5F111NH, R5F111NJ,
L1C R5F111PE, R5F111PF, R5F111PG, R5F111PH, R5F111PJ
R5F51101, R5F51103, R5F51104, R5F51105, R5F5110H,
110 R5F5110J
R5F51111, R5F51113, R5F51114, R5F51115, R5F51116,
111 R5F51117, R5F51118, R5F5111J
113 R5F51135, R5F51136, R5F51137, R5F51138
130 R5F51303, R5F51305, R5F51306, R5F51307, R5F51308
R5F52103, R5F52104, R5F52105, R5F52106, R5F52107,
210 R5F52108, R5F5210A, R5F5210B
21A R5F521A6, R5F521A7, R5F521A8
220 R5F52201, R5F52203, R5F52205, R5F52206
230 R5F52305, R5F52306
231 R5F52315, R5F52316, R5F52317, R5F52318
23T R5F523T3, R5F523T5
24T R5F524T8, R5F524TA, R5F524TB, R5F524TC, REF524TE
24U R5F524UB, R5F524UC, R5F524UE
610 R5F56104, R5F56106, R5F56107, R5F56108
621 R5F56216, R5F56217, R5F56218
RX 62G R5F562G7, R5F562GA
62N R5F562N7, R5F562N8
62T R5F562T6, R5F562T7, R5F562TA
R5F56307, R5F56308, R5F5630A, R5F5630B, R5F5630D,
630 R5F5630E
R5F56316, R5F56317, R5F56318, R5F5631A, R5F56318,
R5F5631D, REF5631E, R5F5631F, R5F5631G, R5F5631J,
R5F5631K, R5F5631M, R5F5631MF, R5F5631N, R5F5631P,
631 R5F5631PF, R5F5631W, R5F5631Y, R5S56310
R5F5634B, R5F5634B_5V, R5F5634D, R5F5634D_5V, R5F5634E,
634 R5F5634E_5V
R5F563NA, R5F563NB, R5F563ND, R5F563NE, R5F563NF,
63N R5F563NK, R5F563NW, R5F563NY
R5F563T4, R5F563T5, R5F563T6, R5F563TB, R5F563TB_5V,
63T R5F563TC, R5F563TC_5V, R5F563TE, RSF563TE_5V
64M R5F564MF, R5F564MG, R5F564MJ, R5F564ML
R5F56514, R5F56517, R5F56519, R5F5651C, R5F5651C_DUAL,
651 R5F5651E, R5F5651E_DUAL
R5F565N4, R5F565N7, R5F565N9, REF565NC,
65N R5F565NC_DUAL, R5F565NE, R5F565NE_DUAL
71M R5F571MF, R5F571MG, R5F571MJ, R5F571ML
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R7S721000, R7S721000_DualSPI, R7S721001,
R7S721001_DualSPI, R7S721010, R7S721010_DualSPI,
R7S721011, R7S721011_DualSPI, R7S721020,
R7S721020_DualSPI, R7S721021, R7S721021_DualSPI,
R7S721030, R7S721030_DualSPI, R7S721031,

Al R7S721031_DualSPI, R7S721034, R7S721034 DualSPI
R7S910001, R7S910002, R7S910006, R7S910007, R7S910011,

RZ R7S910013, R7S910015, R7S910015_M3, R7S910016,

R7S910016_M3, R75910017, R7S910017_M3, R7S910018,
R7S910018_MS3, R75910025, R75910026, R75910027,
R7S5910028, R75910035, R7S910036, R7S910101, R7S910102,
R7S910106, R7S910107, R7S910111, R7S910113, R7S910115,
R7S910115_MS3, R7S910116, R7S910116_M3, R7S910117,
R7S910117_MS3, R7S910118, R75910118_M3, R75910125,

T1 R7S910126, R7S910127, R7S910128, R7S910135, R75910136

3. Smart Manual Support

Smart manual support is delivered independently of e2 studio releases when available. The following devices are
available as of the 27 of July, 2017.

e RX62G
e RX62T
e RX63N
e RX63T
e RX64M
e RX7IM
e RX110
¢ RX111
e RX113
e RX210
e RX220
e RX631
e RX651
e RX65N
e RX24U
e RX24T
e RL78/L12
e RL78/L13
e RL78/G14
e RL78/G13
e RL78/G12
e RL78/G11
e RL78/G10
e RL78/G1F
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4. What is new in 6.0.0?

Component Device Description
Project All The project generation tools in 6.0 have been revised and the look and
Generation feel improved.

The new generator is accessed via the C/C++ Project.

P8 workspace 2707 - C/C++ - & studio
File Edit Source Refactor Navigate Search Project RenecacViews Run Window Help
Mew Alt+Shift+N > [T RZ/G C/C++ project
Open File...

Synergy C Project

4 Open Projects from File System... Synergy C++ Project

Makefile Project with Existing Code

C/C+=+ Project

Project...

1 =X [F1

4|

Convert to a C/C++ Project (Adds C/C+= Nature)
5 Source Folder
Folder

¢ Source File

h Header File

i 2 File from Template
R h F
i g & Class

Convert Line Delimiters To > |
% Code Generator

s ™ Other.. Ctrl=N
Switch Workspace » T

Restart

Import...
iy Export..

Properties Alt+Enter

Exit

The RZ/G project generator is accessed from the RZ/G C/C++ Project
menu item in the same manner as 5.x.

The Synergy project generators are accessed from Synergy C Project
or Synergy C++ Project in the same manner as 5.x.

When selecting the C/C++ Project wizard the following dialog is shown
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Tamplates for New C/C« Project

@ [ um-gea Build

T buddt wiang the COTs managed busld syatem

GCC for Renesas RLTE C/C. - f.nnmbu’w]m

GCC for Remesas RL7E C/C- unm, wu

GCC for Renesas RZ C/C- - Excutable Praject
P A C/Te e Ecutabie Proect for Reneses

GEE for Renesas RZ C/C- - Library Project

oA /e s LBy Projet for Benesss R usng the GOC ARM Ebes
Renesas OC AL € Executable Project
PRI A C Farcutabie Proyect for Remenat 71 78 eting the CORL osichain

Renesas €CRL € Library Project
OTEWE A Gy o o o R LW i e R kb

Renesas OC RX C/C- - hmHlﬁuQxl
™ 4.0/ e Proyect for Banesor B e Benesor CORY tonichas

Renesas CC kxal: = Library
ummomm
PO Benesas Detug Only Prect

«

PP A C/T o + Euerutabie Projectfor Renesas BL 78 sing the G for Renesas RLTA Tooichain

PRI A T/ 4 » Libary Prapect for Benesas KT8 using the GOC for Reness KLTE Tookhain,
GCC for m” C/C + Executable Project
T e T i,
GEC for Remesas RX €/C- + Library Project
™ A C/C e = Library Project for Benesat R using the GCC for Renenas BX Tacichaie

Bhe GOC ARM Embedsed toeihais

IR A C/C » Library Fropect for Benesas X using the Renesas CCRY fooichain

s teicha

Cancel

Note the C Managed Build and C++ Managed Build types are default
CDT projects. Please use the Renesas project types for the device you
wish to use. There are separate entries for each device, toolchain and
project type (Executable or Library) combination.

The actual wizard to create the projects also has an updated look and
feel. The functionality provided is very similar to 5.x.

| New Renesas CC-RX Executable Project

Select toclchain, device & debug settings

Toolchain Settings

Language: @C OCes

Toolchain: Renesas CCRX -

Toolchain Version: | v2.06.00 ~
Manage Toclchains...

Device Settings

Target Device: | R5F51101AxLM

Unlock Deviges...
Endian: | Little -

Project Type: | Diefault

"‘ < Back

Configurations
[] Create Hardware Debug Configuration
E1 (R ~

[[] Create Debug Configuration
RX Simulator v

[ Create Release Configuration

Nm) R

When the project is created all generated files are stored within the
project in the “generate” folder. This is to make it clearer which files
within the project were provided by the project generator.
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Revised The builder components within e2 studio 6.0 have been overhauled
Builder and updated to work well with the latest CDT.
components

The affected toolchains are CCRX, CCRL, GCC RX and GCC RL. For
information on migration of old projects please see the useful
information and workarounds section.

In addition the GCC ARM toolchain being used for RZ development
has been migrated to now use the gnuarmeclipse open source plugins
that are already in use for Synergy.

The new settings dialog are available from the C/C++ Build, Settings
page within the project properties. See below:

P Properties for RenesasGCCRX [m] b3

fype filter texd] Settings T
Resource .
Builders

v C/C++ Build Configuration: HardwareDebug [ Active | ~| | Manage Configurations...

Build Variables
Environment
Logging B Tool Settings B Toolchain &3 Device Build Steps Build Artifact Binary Parsers @3 Error Parsers
Settings
Tool Cgham Editor = cru [J Make the double data type be 64 bits in size
C/C++ General (% Optimization CPUType RX100 -
Project References (% Debug
Run/Debug Settings (# Warnings Architecture Rl M
+ i Library Generator
(53 Settings
(3 Header files Registers reserved for fastinterrupt | Default ~
~ & Compiler
(% Source
% Includes Disable generation of RX hardware FPU instructions

Data Endian Little-endian data ~

Max size of constant operand values | Default ~

22 List [ Generate assembler output compatible with Renesas’ AS100 assembler
~ i Assembler [Jinterrupt handler functions should preserve the accumulator register

3 Source

2 Includes

2 List
- ® ﬁker [ Use JSR instead of BSR for calls (-mjsr)

[ Generate position independent code and data (-mpid)
[ Disable String Instructions

5 Source
(3 Archives
(3 Miscellaneous

(£ Other
~ & Objcopy
(8 General
v

The look and feel for each toolchain is similar to before but there are
some considerations worth noting:

1. The Toolchain tab

e This tab controls the selected toolchain and version.
The “Change toolchain version” functionality present
previous e2 studio versions has been removed and
replaced with this.

e In addition extra tools such as “Objcpy” or “Libgen” can
be enabled on this tab. When enabling the checkbox
for the tools they will only then appear in the builder
settings.
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P Progserties fox ReneumGOCRE

- e
Reseurce

Configuestica:  Marhwareliebug | Active | || Mansga Conbiguistion.

1) Tool Settings ) Tockhsin 1) Device . Muid Steps Buikd Artifact [} Binary Parsees @ Frece Pactaes.

Change Teakhai
Toslchain: | GEC for Renesas B2C
erion:  dAAATON

dditicrad Tooh
[ Coente Dkjeopy

2. The Device tab

e Previous versions of e2 studio had a special
preference page for the currently selected device. This
has been removed and an additional tab named
“Device” has been added to the build settings.

e Here it is possible to change the device, re-generate
project generation files and update the build settings
accordingly.

I Propeties for RenrcGCORY

w C/Cen Buid Configuration:  HasthwareDebug [ Active | ¥l i ot

Build Vanables
Emarzament
ek 1 Devier o QuildSteps  BuldAdifact ) Dinary Pavsers (@ Trvoe Parsesrs
Settings
Teed Chain [dtor Catrerd Devace

C/C-+ General Group: RXI1T

Praject Referances Device RSF511150FM

Ry Dinbsg Stein

Reset/Chargs Device
[Ccrumge Deviee | RIFST115AFM
Generzte Files: (These will averwrite any files slkeady in your project)

¥ [Ji gtnerate
[ 19 Snker_scripedd

senledine
nterrupt_hasdiees h
hwinit
wypedefineh

Oopboooaa

[ Update Build Settings (for selected configuration anly)

o
3. Linker section changes

e For CCRX and CCRL the linker sections are
represented as a single string. The section editor
is not shown on the settings page. To access the
graphical section editor press the “...” button.

e For all GCC tools there is no longer a graphical
section editor integrated into the settings user
interface for the GCC build plugins.

R20UT4092EE0100 Rev.1.000 Page 15 of 34
RENESAS



e2 studio 6.0.0 Release Note

e Instead it uses the .Id linker script directly. A
special graphical editor of .Id files has been
integrated within the e2 studio. Simply double click
the .1d file in the project and you can again edit the
sections graphically.

T ReneunGCORE HardwareDebug = B v G £ Hew Conmaicn CALE =i@in
A1 | W-E-E-@-e-0-Q-S
o] RemesasGOORE [ bnker_seriptld

Sectlons
& MEMORY.

twanch
O ardharellebug Launch

HeardwareDebug) L1l sasBECHE. 8
Iardwaretetug/ Libgen_Sajobs

4. Renesas Quick Settings menu item
e In previous versions of e2 studio there has been a
menu hamed “Renesas Quick Settings”.
e This menu item used to take you directly to the build
settings for the selected project.
e This functionality cannot be implemented in e2 studio
6.0 so the menu item has been removed.

Installer All The e2 studio product structure has been enhanced so that each
device can be installed in its own independent way.

Each device’s support is versioned independently from the main 6.0
product. It means that updates to one device will not affect the other
devices.

The installer allows you to select this at installation time.
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€ studio Setup

&7 studio 6.0.0.R20170720-1318 Setup

Select the device families you wish to install components for | z E N E SAS

* Welcome ~

. Support fer Synergy Devices
i - .
RAENESAS SRy Includes Build, Debug & Code Generation

* Install Folder
Device Families
0 \ Support for RX Devices
RX Includes Build, Debug & Code Generation

0 \ Support for RZ Devices
| = . Includes Build, Debug & Code Generation

Support for RH330 Devices
1 PP
RHB85S0 Includes Debug

0 \ Support for RL78 Devices
IRLU_F B Includes Build, Debug & Code Generation
v
Select All
v201707201359 =< Back Next » Install Cancel

The above example shows a user only installing the Synergy device
family. Subsequent updates of other device families will not affect this
installation unless the main core of the product is also updated.

To see the version of your installed device feature you can visit the
About Box.

P About € studic O
Renesas ¢ studio

Version: 6.0.0
Build Id: R20170720-1318

Parts Copyright (C) 2010-2017 Renesas Electronics Corp.
All rights reserved.

e studio IDE is an extension of software developed for
eclipse.org,

e studio IDE is based on Eclipse SDK 4.6.1 (Neon.1)
and CDT version 9.2.7,

Source code for the Eclipse Foundation plug-ins is available
from www.eclipse.org, under the Eclipse Public License "EPL",
see http://www.eclipse.org/org/documents/epl-v10.php

cCEEEgSOOwPCESHEHE

() | nstaliation Details

Clicking on the device will give the installed versions of components for
this device. e.g. In the example below RX was clicked:

R20UT4092EE0100 Rev.1.000
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P8 About & studio Features O x

Provider Feature Mame Version Feature Id

Renesas Electronics Corp. GCC for Renesas RX Build Sup... 6.0.0520170719... com.renesas.e2studio.device.rx..,
Renesas Electronics Corp. GCC for Renesas RX Support ... 1.0.0420170710...  com.renesas.ide.supportfiles.nog
Renesas Electronics Corp. Renesas CCRX Build Support 6.0.0020170719...  com.renesas.estudio.device.rx...
Renesas Electronics Corp. Renesas CCRX C5+ Import/Ex...  6.0.0+20170718...  com.renesas.eZstudio.device.n..,
Renesas Electronics Corp. Renesas CCRX HEW Import 6.0.0520170718...  com.renesas.estudio.device. ...
Renesas Electronics Corp. Renesas CCRX Support Files 1.0.0520170710...  com.renesas.idesupportfiles.nue
Renesas Electronics Corp. Renesas RX Debug Support 6.0.0020170718...  com.renesas.estudio.device.n...
Renesas Electronics Corp. Renesas RX¥ Debug Support Fil..  1.0.0420170710...  com.renesas.ide.supportfiles.ned
Renesas Electronics Corp. Renesas Smart Configuratorf...  6.0.0420170707... com.renesas.eZstudio.tools.smar
< >

GCC for Renesas RX Build Support
Version: 6.0.0,20170719-0831

Copyright (c) Renesas Electronics Corp. 2017, All rights reserved.

|/‘_7\| L -
\eo) License Plug-in Details Columns...

This version information will be valuable if you need to discuss
problems you encounter with Renesas technical support contacts.

Updated user All Some changes have been made to the e2 studio 6.0 user interface to
interface improve the usability of the user interface.

The most major improvement is the introduction of the Launch Bar.

File Edit Source Refactor Navigate Search Project Renesas Wiews Run Window He

% Debug [c7 Synergy_Test Debug

This launch bar allows you to very clearly understand what will happen
when the build and debug buttons are pressed. The selected project
and debug configuration in the drop list will provide the context for the
operation.

In addition the debug toolbar buttons have been switched off from the
debug view and added to the main debug toolbar.

Rz Rz When using the RZ debugger in previous e2 studio semihosting was
Semihosting supported but did not fully support the SYS mode. This mode of
operation is now supported in the e2 studio 6.0 RZ debugger when
using the Segger J-link emulator.
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Smart All The Smart Browser has been enhanced to show when updates are
Browser available for items shown within the user interface.
*] Problems F Tuks (D) Conscle [~ Properties ® Memaory Usage [] Stack Anstysis @ Sma- =
When items such as updates to documents or new tool news
information are available a notification bubble will be displayed
informing you that new items are available.
New Notification x
"There are 14 new user's manual
|There are 3 new application notes
{There are 5 new tool news
Click Qere to view detail
RTOS Synergy  Stack usage is now shown in a graphical way when using the Partner
Graphical OS plugin and ThreadX.
Stack Usage
XML Synergy €2 studio now has a XML file comparison tool built into the UI. This can
Comparison and RX, be used for the configuration.xml files in the Synergy editor and the
Rz Smart Configurator.

Right click on the file in the project tree that needs comparison and

select “Compare With->Local History...”

R20UT4092EE0100 Rev.1.000
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, e NEW TTTEa0 UUjet s %]
io¢ configuration ° L
RIFSTG27TH2E  New > |
§7G2-DK.pinc Open 3
I8 synergy_cfg Open With >
Synergy_Test
Synergy_Test SRR g
Copy Ctrl+C
Paste Ctrl+V
K Delete Delete
Move... I
Rename... F2 ﬁlncks Pins | Threads | Messaging
Ly Import. )
iy Export. \_
Refresh
1n7,13:35
Show in Remote Systems view 7. 13:10
Run As >
Debug As >
Profile As >
Team >
Compare With > Each Other
Replace With b Local History...

Run C/C++ Code Analysis
System Explorer

B ® %

Command Prompt

Properties Alt+Enter

The following dialog is then displayed:

R Tiene
B 01/08/2017, 1335
o 01/08/2017, 1310

These are the list of revisions of the file that was selected in the project
tree. Double clicking an instance of the file will then compare with the
current version on disk. A difference window is shown showing the
differences:
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&Y Compare configuration.xm| Current and Local Revision &3
E_' Renesas XML Structure Compare

&8 Synergy Configuration
&8 Synergy Configuration

‘_:‘..’ Text Compare

Local: configuration.xml
[ <component apiversion=" clazs="Framework Ser
<description>Framework I2C: Providess[Frame
<originalPack>Renesas.Synergy.1.2.1.pack</e
</component>
<component apiversion="" class="HAL Drivers”
<description>Data Transfer Controller: Prov
<originalPack>Renesas.Synergy.1.2.1.pack</o
</component>
<component apiversion="" class="HAL Drivers”
<description>RIIC: Provides=[I2C Master]</d
<originalPack»Renesas.Synergy.1.2.1. pack</o
</component>
</synergyComponentSelection>
<synergylcuConfiguration/>
<synergyMessagingConfiguration/»
<synergyModuleConfiguration>
<module id="module.driver.cgc_on_cgc.@">
<property id="module.driver.cgc.nase™ value
</module>
<module id="module.driver.elc_on_elc.8">
<property id="module.driver.elc.name” value
</module>
<module id="module.driver.ioport_on_ioport.e”
<property id="medule.driver.ioport.name® va
</module>
<module id="module.driver.fmi on fmi.e">

_l,ocal history: configurationaoml 1 Aug 2017, 13:10:29 |

SRS - S

<originalPack>Renesas.Synergy.1.2.1.pac A
</component>
<component apiverszion="" class="Expreszs L
<description»Express Logic ThreadX: Prc
<originalPack>Renesas.Synergy.1.2.1.pac
</component>
</synergyComponentSelection>
<synergytoduleConfiguration»
<context id="_hal.8"»
<module id="module.driver.cgc_on_cgc.@"
<module id="module.driver.elc_on_elc.e"
<module id="module.driver.ioport_on_iop
<module id="module.driver.fmi_on_fmi.e"
</context>
<context id="rtos.threadx.thread.e">

<property
<property
<property
<property
<property
<property
</context>

id="_symbol™ value="blinky_th

id="rtos
id="rtos
id="rtos
id="rtos
id="rtos

«threadx
.threadx
«threadx
.threadx
+threadx

Jthread.name®
-thread.stack
«thread.prion
.thread.autos
.thread.times

</synergyModuleConfiguration>
<synergyPinConfiguration>
<pincfg active="true” name-"57G2-DK.pincf
</synergyPinConfiguration> v

< > <

Help System

All

The help system in previous versions of e2 studio was not well
organised which meant finding topics was not easy.

In e2 studio 6.0 the help has been re-structured to make it easier to

find what you are looking for. See below:

P :
R -[?7)7 P .

o2 stuehie Phug-in et
o Reneias FLTS Sevelator
# L0 Renesin Region specdic devices
# A Code Cenerstor
¥ I imteguataan Serace
% Frequently Avked Cuestions
4 I Working Sample Support
2 shudha Synchionie werkspace with
4 I Renesss Reai-time O5 R600VE

Using the help system

Browss togecs = the Comtuas irama | ) on the It Clci on 2 topc ta have @ cispiayed. Use the Back and
Forward bufions 10 nanagats within th history of wewed topcs

Searching

To quichly locate fopcs on @ paticidar subpect in the docunsentalion, enler & query i e Seosch Seid Use the
Search fams (') 1o dispiay the Search wew You can namow the scope of your saarch by seecting only the
sections you are interasted in

Synchronizing

Chclang the Show in Table of Contents button (5] wil selsct that topic in the navwgation tee, The Link with
Contents buston | 7] keeps the nmigation tree synchronized 1o the curment tapc

= U0 Stack Aabrins
i 10 Gt Configurater
Hom b buid o2 studic geresated proj

Capabilities

To show documantation about capabinies that are cisabisd in the appication, SHct the Show ANl Topics tutton
() This affects the table of contents and search resulls

Keyword Index
= [ Detagging Pregeets
e To show an siphabeticalty soded index of keywords select the Index Frame (5] Not all peodects contan an
Dby Tioubleibeating index
Dn Chp Debug Function Specficatior
Pathen Sergting
* < Other Notes on Usage ||

Smart
Configurator

RX, RZ

The main feature improvements for Smart Configurator in e2 studio 6.0

include:

e Code Generator driver support for RX64M [37 components]

e CG driver support for RX65N/1 (+2MB devices) [37
components]

R20UT4092EE0100 Rev.1.000
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e CG driver support for RX130 (+512KB devices) [35
components]

E2 Emulator RL78 E2 emulator support has been added to e2 studio 6.0. This emulator
offers all the same functions as the E1 emulator.

It also offers:

e Consumption current measurement support.
e External trigger support.

The Consumption current measurement shows graphically the
current drawn by the board.

It allows monitor points to be set which are shown on this view as
markers. This allows you to tie the source code to specific power
consumption.

— 1 i
| 26 Consumgption Current AIRED 49 ™ @ % | B = G =
uh Avarags Currant |
513785 uh
| H H Maximum Current
8090 4 520022 A
Curgor Currart
| 520022 uh i
i i i Gursar Tima
4000 = 0 me
A 210 ms
2000 —' [ i ms
S S i e e e L
|
Application All e2 studio has many debug views and not all are supported for all

device families.

This can cause confusion so a new feature has been added to close
debug views that are not supported by the current debug session.

This is available from the Window menu under the Perspective menu.
Selecting the device will close all windows not supported by that
device.

Note this menu item is only available in the debug perspective.
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P workipace’t « Debug - CCRD spret/ue e _prograec « o cudio

Fie Edt Souece Refscior Muigate Search Project RenesssViews Run  Window  Help

B ||t || m || % 0eug w || 7 CCRX_S4_Progect Debug How Window - & v G

& Mew Connec tan.., - e
Fditar
i s & Appesance
15 Debug Shesas Wopoe s | || =0 oxvdbe
v [ Synergy_Test Debug [R OB Hardware Debugging] Perspective + Open Perpectne : | Hame
1 <termanated, exit val brgdb (7821
CRminsbad, St Vil 0 GDB rver Nevigation g Customize Perspective...
w [ 4 Praject Denisg [Renesas Semulstes Debugging (R, FLTE)| " Refresh Debug Views Save Perspeciive As.
w 5B CORN S Prejectx (1] ; Reset Perspective... |
P Theesd 511 fsingle care) ded' Signal: SIGTRAP:Trace/breakped o ooess [ Sin ik o Davice 5
= PowerON_Reset_PC() at reset_progeam 90 0ufif o000 i
wd ne-eif-gdb --noforce-Bdbit-double (T8.2) ot Pertpectnm

ol GOB server Close All Perspectives

o reuet peoesame

Enhanced Synergy  The Synergy threads page has had the following enhancements made
Threads toit:

Page

e Keyboard navigation within the module stack viewer
e Renaming threads will refactor code accordingly
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5. Useful workarounds and information for 6.0.0
Please visit the Renesas FAQ for e2 studio for the latest up to date information:
Online FAQ link.

ID Component  Workaround or information
Application This version of e2 studio is based on Eclipse Neon.1 and CDT 9.2.1. This
release note does not describe the Eclipse framework and CDT plugin issues
and fixes. You can find the detailed information on the sites below:

For information on the Neon release see here:
https://projects.eclipse.org/releases/neon

CDT:

Has been significantly improved and this version contains a major version up
over 5.4:

Please see New and Noteworthy for CDT here:

https://wiki.eclipse.org/CDT/User/NewIn90
https://wiki.eclipse.org/CDT/User/Newln91
https://wiki.eclipse.org/CDT/User/NewIn92

The Eclipse bug tracker is here:
https://bugs.eclipse.org/bugs/

SH support The Renesas SH device family is no longer supported in e2 studio.

If you need to use the SH device support please use e2 studio 5.4 or earlier.

Importing old  All projects being migrated into e2 studio 6.0 from previous e2 studio versions
projects into  will need to be migrated to the new builder plugins. The new builder plugins have
6.X different user interface pages and different option IDs.

Upon opening an older workspace the following dialog would be displayed:

PS5 Older Workspace Version

'0] Workspace '/C:/Users/b3800109/e2_studio/workspace54/' was written with an older
' version of the product and will be updated. Updating the workspace can make it
incompatible with older versions of the product.

Are you sure you want to continue with this workspace?

[C]Do not warn again about workspace versions

Cancel

Clicking OK will update the workspace to e2 studio 6.0.

Importing an existing project to the workspace or opening a workspace with old
projects will automatically start the legacy project upgrade procedure.

If for some reason this process does not start it is also possible to launch the
“Upgrade Legacy of e2 studio Projects...” from the project context menu.
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L]

5 CORN_34_Profect [Mardwa—='-=—"
eew
o et

Oppan in New Window
Shewin

5 OB Project

The automatic system pops up a message bubble in the bottom left of the e2
studio application window.

BB MBE~-m-=0O

-

Project Upgrade Required

Projects in this workspace require upgrading before they can build,
Click here to upgrade these projects.

lgnore i
" Smart Browser Notification Startup LS E_

After selecting the menu item or clicking the bubble the following dialog will be
shown:
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Upgrade Legacy e2 studio Projects

€3 Vou must select at least 1 project

{[ | .= CCRX_54 Project [HardwareDebug]

?\ Finish Cancel

To upgrade the project, click the corresponding check box and then click Finish.
Note, this will update the project to the latest build plugins and options. Before
doing this you should ensure your project is backed up as this operation is not
reversible.

It is possible to upgrade multiple projects in a single operation.

For the GCC toolchains for RX and RL changes have been made to the build
options which mean we cannot guarantee the same binary output after upgrade.
Please consider this before upgrading to 6.0.

For the GNUARM-NONE toolchain projects, they can be converted to 6.0 project
but options and configuration might not be migrated exactly the same as original
project. Please consider using 5.x in the meantime if you have any difficulty in
migrating to 6.0, or create a new project on 6.0 environment.

Another consideration for migration is that debug configurations when opened in
6.0 will also need to be migrated. The following message will be displayed.

P8 Migration needed

This launch cenfiguration needs to be updated for the current version of e studio
before it can be used.

Once migrated this configuration will not be usable in clder e2 studic versions,

Do you wish to migrate it now?

Yes Mo

Please ensure that your projects are backed up or in revision control before
migration allowing you to return to older versions if required.
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Toolchain Before e2 studio 6.0 the toolchain management facility automatically upgraded
Management or downgraded the imported project to the latest tools installed on the host
machine.

This no longer happens in e2 studio 6.0. Instead the toolchain remains the same
and user operation is the only way to change the toolchain version.

This operation is now available within the build settings on the toolchain tab. An
example of CCRX is shown below:

P% Properties for CCRX_54_Project O X

type filter text Settings =14 -
Resource
Builders
~ C/C++ Build
Build Variables
Enviranment
Logging 1% Tool Settings  Toolchain  Device & Build Steps Build Artifact Binary Parsers @3 Error Parsers
Settings

Configuration:  HardwareDebug [ Active ] || Manage Configurations...

Tool Chain Editor
C/C++ General
Project References
Run/Debug Settings

Current Toolchain
Toclchain: Renesas CCRX
Version:  v2.06.00

Change Toolchain

Toolchzin: | Renesas CCRX ~

Version:  |+2.06.00 ~

If the particular toolchain version does not exist and build is performed then an
error message is displayed and the build will fail.

DS-5to e2 The DS-5 to e2 studio import and conversion utility is not provided in e2 studio
studio 6.0.
converter

To import a DS-5 project to e2 studio 6.0, please use the import facility in 5.4
and then import into 6.0.

This utility will be provided in a later release of 6.0.

RZ Toolchain  The now legacy KPIT GNU ARM-NONE toolchain is still supported within the e2
studio product but now using the gnuarmeclipse plugins.

In addition RZ within e2 studio now supports the GNU ARM Launchpad
toolchain. Available from https://launchpad.net/gcc-arm-embedded.

One drawback of this toolchain is that it does not have a standard library builder
provided in the same manner as the legacy KPIT ARM-NONE toolchain. To use
this feature for ARM Launchpad and gain access to the more efficient optlib
libraries a further download is required.

This can be downloaded within the e2 studio installer or directly from here:
https://gcc-renesas.com/rz/rz-download-toolchains/

Once integrated it is possible to integrate the library generator from the toolchain
tab of the build settings page.
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P8 Properties for GCC_RZ m} %
type filter text Settings f=1 - -
Resource
A
Builders
~ C/C++ Build Configuration: | HardwareDebug [ Active ] ~ | | Manage Configurations...

Build Variables
Environment
Logging
Settings
Tool Chain Editor Current Toolchain
C/C++ General Toolchain: KPIT GNUARM-MONE-EABI Toolchain
Project References Version:  v16.01
Run/Debug Settings

) Tool Settings & Toolchain &) Device 4" Build Steps Build Artifact Binary Parsers @3 Error Parsers

Change Toolchain
Toolchain: | KPIT GNUARM-MNONE-EABI Toolchain

Version: | w18.01 ~

Additienal Tools
Create Library generator
Create Flash image

See “Create Library generator” option. Once checked the library generator
(libgen) is added to the available tool settings.

CCRX to The CCRX to GCC e2 studio import and conversion utility is not provided in e2
GCC studio 6.0.
converter
To import and convert a CCRX to GCC and e2 studio 6.0, please use the import
facility in 5.4 and then import into 6.0.
This utility will be provided in a later release of 6.0.
QE If QE for TCP/IP V1.0.0 is used, please update it to V1.0.1.
compatibility ~ Other QE series can be used with e2 studio 6.0.
What is QE?
https://www.renesas.com/products/software-tools/tools/solution-toolkit/ge.html
Details of QE for TCP/IP
https://www.renesas.com/products/software-tools/tools/solution-toolkit/qe-ge-for-
tcp-ip.html
5954 Application If you experience the error message “org.eclipse.swt.SWTError: No more
handles” this can be caused by certain multi-monitor software and the Eclipse
framework.
If this error occurs there are 2 workarounds:
1. Use a single monitor display.
2. Uninstall the multiple monitor software from your graphics chipset
vendor and revert to the standard Windows multi-monitor feature.
6981 RL78 When debugging IAR C source file with an OCD emulator (E1), the Monitor
Debugging program area (0x00002-0x00003) is used.

So this area must be excluded from usable address space. Please add '-HFF' in
the linker option.

- Open Property.

- Select [C/C++ build]-[Settings] at left side.
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- Select 'lAR RL78 Xlink linker" at right side, add '-HFF' at the textbox ‘command'.

Not doing this will cause problems with connection and download when using
interrupts.

NA

Application

If you are experiencing slow building of projects within e2 studio there are some
possibilities to improve.

The system environment will attempt to find the make.exe tool via the system
environment. If you ensure the directory make resides in is at the start of the
path variable it will find it more quickly. Especially important if there are network
drives in the path.

In the project properties, C/C++ Build tab, behavior tab you can switch on
parallel build. This will take advantage of the multi-cores on your host machine if
it has them.

NA

RZ GCC

In 3.0 the KPIT GCC RZ toolchain was supported at version 14.01. This version
is no longer supported within e2 studio.

KPIT modified the name of their ARM toolchain to be ARM-none-eabi to follow
standard ARM naming convention like other GCC toolchain vendors.

The ARM-none toolchain is available at versions 14.01, 14.02 and 16.01 from
the www.gcc-renesas.com website. The binaries in the 14.01 version are
identical to those used in the 14.01 RZ toolchain.

Once the toolchain is installed your projects will be imported and ported to
ensure there is as little disruption as possible due to this change.

NA

KPIT GCC

The KPIT toolchains are now no longer supported by the www.kpitgnutools.com
website. Support is now available from the www.gcc-renesas.com website.

In addition, there are two new releases for the GNU toolchains for RX and RL78.
These are now named Renesas GCC for RX and Renesas GCC for RL78.

Both integrate into e2 studio and can be selected from the project wizard.

2010

HEW
Importer

Symptoms: Project fails to build after importing a legacy project from HEW

Conditions: If a long filename or path is used, and the HEW project importer is
used, the project may fail to build.

Workaround: Move the original HEW project to a shallow directory structure (i.e.)
C:\Workspace and import from there. Also, ensure that the HEW project is
relocated before importing into e2 studio.

1922

Application

Symptoms: Project fails to build in first instance after archive project import (not
from HEW)

Conditions: If an archived project is imported, it may fail to build the first time,
due to a residual .d file.

Workaround: Clean and Build a second time.

2762

CODAN

When using assembly code within a C source file, CODAN errors can be
observed in the editor. Even though the project builds successfully.

We do not have a workaround for this at this time.
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On occasion, you may also see CODAN errors for C source files. This is
normally a case of the indexer needing to be refreshed.

Right click on the project, select Index->Freshen all files. Then right click again
select Index-Rebuild. This should solve unexpected CODAN errors in C source
files.

2728

GDB

Step into does not always work when using the CC-RX 1.02.01 toolchain.

To ensure this behaves correctly you will need to use CC-RX 2.00.00 or greater
as this issue with the debug information is corrected in this release.

NA

Eventpoints

If eventpoints do not always work just after they are set, you can use the "Apply
to Target" toolbar button in the Eventpoint view to send the Eventpoints to the
target manually. This will always ensure the debugger target has all the required
eventpoint updates before execution starts.

5772

IAR Plugins

The IAR Plugin Manager is included in e2 studio and provides support for RX,
RL78, RH850 and RZ (ARM).

This tool, simplifies installation and configuration of IAR toolchain plugins. You
can access this though Help -> IAR Embedded Workbench plugin manager.

5903

Code
Generator

For the following RL78 code generator project, "Peripheral Functions" view tabs
may not be operated with double-clicking "Peripheral Functions" branch of
Project Explorer view.

After creating/loading the project, please show "Code Preview" view by double-
clicking of "Code preview" branch at Project Explorer tree at first. Then, please
access Code Generator setting tabs by double-clicking Project Explorer tree or
using pull-down menu by pressing triangle button at the up-right corner of
Peripheral Functions view.

RL78/G12, RL78/G13, RL78/G14, RL78/G1A, RL78/I1A, RL78/F13, RL78/F14,
RL78/F12, RL78/L12

6184

RL78/CC-RL
debugging

When the load module for RL78/G10 which created at CC-RL is debugged in E1,
please specify the following option:

[Linker] -> [Device] -> "Set enable/disable on-chip debug by link option

7217

Application

The restore default settings does not restore all of the options set during project
generation. Instead, it sets the defaults to the base settings for the device family
in use.

7524

Rz/T1
Debugging

In a RZ/T1 RAM-based project, the "Reload" function does not work.

Reloading or re-downloading during debugging resets the device and the RAM
content is erased.

To continue the debugging, disconnect and connect the debugger again.

Use spaces
as tabs

Eclipse and CDT both have settings for use spaces as tabs. The option on the
Editor preferences page conflicts with the CDT formatter settings.

To change the use spaces as tabs option in e2 studio please use this page:
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Installer In some situations, the AVG virus checker appears to interfere with the e2 studio

problems installation process. If you experience such a problem, please temporarily
disable the AVG tool and try the installation again.

Antivirus In some situations, the Norton anti-virus tool can interfere with the building of

Renesas Synergy projects. If possible, please disable the antivirus program
when building Renesas Synergy projects on systems with Norton Antivirus

installed.
Green Hills When debugging the RH850 object built with the Green Hills compiler in e2
RH850 studio, specify the following option for the compiler option.
Projects
-gtws

The GUI setting menu is as follows.
[GHS C Compiler for V800 Standalone]-[Debugging Option]
"Generate Target-Walkable Stack" -> On

If this option is not specified, Step Over and Step Return may not work properly.
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6. Open iIssuesin 6.0.0

Open issues in the e2 studio 6.0 product will be kept up to date here:

Please visit to see the latest open issue list.
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7. Appendix

7.1 Website and Support

Renesas Electronics Website
http://www.renesas.com/

Inquiries
http://www.renesas.com/contact/
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Notice

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for

the incorporation or any other use of the circuits, software, and information in the design of your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by

you or third parties arising from the use of these circuits, software, or information.

Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other disputes involving patents, copyrights, or other intellectual property rights of third parties, by or

arising from the use of Renesas Electronics products or technical information described in this document, including but not limited to, the product data, drawing, chart, program, algorithm, application

examples.

No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others.

You shall not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any and all liability for any losses or damages

incurred by you or third parties arising from such alteration, modification, copy or otherwise misappropriation of Renesas Electronics products.

Renesas Electronics products are classified according to the following two quality grades: "Standard" and "High Quality". The intended applications for each Renesas Electronics product depends on the

product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic
equipment; and industrial robots etc.

"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key financial terminal systems; safety control equipment; etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems, surgical

implantations etc.), or may cause serious property damages (space and undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas

Electronics disclaims any and all liability for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for which the product is not intended by Renesas

Electronics.

When using the Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, "General Notes for Handling and Using Semiconductor Devices" in the

reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat radiation

characteristics, installation, etc. Renesas Electronics disclaims any and all liability for any malfunctions or failure or accident arising out of the use of Renesas Electronics products beyond such specified

ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific characteristics such as the occurrence of failure at a

certain rate and malfunctions under certain use conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please ensure to implement safety measures to guard them

against the possibility of bodily injury, injury or damage caused by fire, and social damage in the event of failure or malfunction of Renesas Electronics products, such as safety design for hardware and

software including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures by your own responsibility as warranty

for your products/system. Because the evaluation of microcomputer software alone is very difficult and not practical, please evaluate the safety of the final products or systems manufactured by you.

Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. Please investigate applicable laws and

regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive carefully and sufficiently and use Renesas Electronics products in compliance with all

these applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws

or regulations. You shall not use Renesas Electronics products or technologies for (1) any purpose relating to the development, design, manufacture, use, stockpiling, etc., of weapons of mass destruction,

such as nuclear weapons, chemical weapons, or biological weapons, or missiles (including unmanned aerial vehicles (UAVs)) for delivering such weapons, (2) any purpose relating to the development,

design, manufacture, or use of conventional weapons, or (3) any other purpose of disturbing international peace and security, and you shall not sell, export, lease, transfer, or release Renesas Electronics

products or technologies to any third party whether directly or indirectly with knowledge or reason to know that the third party or any other party will engage in the activities described above. When exporting,

selling, transferring, etc., Renesas Electronics products or technologies, you shall comply with any applicable export control laws and regulations promulgated and administered by the governments of the

countries asserting jurisdiction over the parties or transactions.

Please acknowledge and agree that you shall bear all the losses and damages which are incurred from the misuse or violation of the terms and conditions described in this document, including this notice,

and hold Renesas Electronics harmless, if such misuse or violation results from your resale or making Renesas Electronics products available any third party.

This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products.

(Note 1) "Renesas Electronics" as used in this document means Renesas Electronics Corporation and also includes its majority-owned subsidiaries.

(Note 2) "“Renesas Electronics product(s)" means any product developed or manufactured by or for Renesas Electronics.

(Rev.3.0-1 November 2016)
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